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Stage 12
HOW TO DO AN ERRATA

ERR
*The codes UA, ReF, MuP, MiM, AnN, CoR, ReV, CdE, PrF are the codes to be added to the file name which is
otherwise authorlastname[code]yearV01.docx. Each of these stages also links to the content in the workflow
below.

Stage 1 SET-UP Action
and date

Notes: add X
when done.

UA

1. Email Final submission form to author adding the manuscript number to the second
page using OJS 3.1 content management system.

In the dropdown menu select: “This is not a revision of an existing file.” The file may be
overwritten if the file names are similar. Add “Final Submission form as a pdf.”

TEMPLATE:
TITLE: “Final Submission Form for Manuscript #number.”

Dear [Firstname],

Please find attached the ESTS final submission form to prepare your file for production. The form is provided
in .docx format. Any questions, please do email me as per the instructions enclosed in the next two weeks. We
look forward to hearing from you soon.

Sincerely, 

Amanda

Managing Editor 

Dr Amanda Windle, Managing Editor
Editorial Collective at ESTS | 4S

11 Jan

1. Follow-up email, by OJS system, and if needed email by Gmail searching for
author’s email. Check email is up to date which can be done by cross-referencing
with Gmail.

THREE TEMPLATES

TEMPLATE 1.
TITLE: “Follow-Up on Final Submission Form for Manuscript #number.”

Dear [Authorfirstname],

I'm emailing to check-in and see if you have received my email (with attachments) via the OJS system last
week?. Your manuscript is my immediate priority, so please do send it to me in the next week or so, at your
convenience via the OJS system.

Any other questions, please let me know. And, also thank you for your patience.

Kind regards,

Amanda

Managing Editor 

Dr Amanda Windle, Managing Editor
Editorial Collective at ESTS | 4S

TEMPLATE 2.
TITLE: “Editing the Word Limit”
Dear [Firstname],
Thank you so much for sending back the Final Submission Form and the Unanonymised Manuscript. I had a
quick check on the final word length of your submission which is [XX,XXX] words. Without the references
(XXXX words, X pages) the manuscript is [XXX] words over the 9,000 word limit for research articles. Can you
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please spend a little time, reducing this word length? We try to make sure that the time spent in copyediting
and production is fair for all. If you need suggestions or further advice, please do get back in touch with me, or
[XXXX], your Associate Editor.
Kind Regards,
Amanda

Dr Amanda Windle, Managing Editor
Editorial Collective at ESTS | 4S
TEMPLATE 3
Dear [firstname]

Thank you so much for sending back the Final Submission Form and the Unanonymised Manuscript. I had a
quick check on the final word length of your submission, and on first look, this looks great! I'll be in touch in
the next few weeks to progress the copyediting of your manuscript.

Kind Regards,
Amanda

Dr Amanda Windle, Managing Editor
Editorial Collective at ESTS | 4S

TEMPLATE 4
Dear [authorname],

I'm writing to you by email to follow up on your manuscript #[XXXX]. Did you receive my email via the OJS
system on the [date] or the [date] to say that we're ready to progress your research article into copyediting
and production. If you are working on the documents that I sent, that's great, but I just want to make sure you
received these communications okay?

Kind Regards,
Amanda

Dr Amanda Windle, Managing Editor
Editorial Collective at ESTS | 4S

2. Download and save:

FINAL SUBMISSION FORM Authorname_FinalSubmissionForm_year.docx

FINAL UNANONYMISED DOCUMENT Authorlastname_UA_yearV01.docx

IMAGES Authorlastname_Fig1.png

PERMISSIONS PermissionsAuthorlastname21.docx

Check word length and number of additional elements (tables and images).

3. Switch on formatting mark-up and style panes and colour coding too look
something like this:
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Get DOI from Submissions: metadata tab. Or wait, until the issue has been assigned. It will look
like this: https://doi.org/10.17351/ests2022.489. It is ALWAYSmade up of several parts with the
last number changing per issue, and the year date changing as per the calendar year:
https://DOIhomepage/ESTSnumber/journalacronymYear.uniqueidentifer

4. For Reference:
https://www.ed.ac.uk/files/atoms/files/checking_dois_before_publication_in_ojs
.pdf

5. Addmetadata from final submission form: (header/footer), style first page, convert
endnotes to footnotes. Review spaces, par breaks and special characters.

6. Add STS-I to the document. Add “Data Availability” section, make sure all
references are added with ARKs.

7. Convert files to MSWord, save as: Authordate_UA_V02.docx
8. Check language setting and change on the review ribbon of MSWord.

Language choice: [American.]
9. Check image permissions.
10. Check image size and combine images with the texts later if they aren’t already

added to the word document.
11. Compare new text to old text.

Stage 2 REFINE
ReF

Action
and date

Notes: add X when
done.

REF
12. Save as: AuthordateReFyearV01.docx

13. Apply mark-up styling to:

a) Titles
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b) Subheads (The title and subheads are a quick way to assess the organisation of the

argument and if the paper focuses on the readership enough. It can show

asymmetries in the material and is a clear indicator of how clear the argument and

discussion will progress, whether it is a close argument on a single topic, or a broader

schematic, both are okay, but do the headings align with what has been written?

Asking authors to make a change on this can improve and attune the paper.)

c) Keywords

d) Subhead levels of titles

e) Epigraphs

f) Acknowledgements, Text and Poetry extracts

g) Notes

h) Captions to images (Figures)

i) Blockquotes

Extra line space like a stanza in poetry or require an ornament.

14. Acknowledgements then Author Biography.

15. Title the Bibliography as References and check they are in Chicago MofS (which preferred

style, then quick Y or N).

Tip: This is a sign if the author hasn’t converted the paper to our submission format.

16. Check Keywords are not capitalized, and they are not in alphabetical order.

17. Convert endnotes to footnotes.

Code:

Style 18 Footnote Reference.Merriweather Light, 8pt, 1.2 leading, justified.

Footer citation for page 2.

Style 19: Footnote TextMerriweather Light, 8pt, 1.2 leading

Footer page numbers are on the right-hand side of the page.

18. After these “silent changes” mark the first instance of a global change—like

capitalization of a certain term.

19. Send back either as a pdf and a word document (the author’s choice for comments).

20. Check figure placement and add suitable places where the figure can be cited in the
text and if the image appears before or ahead of these mentions.

21. Add inline links for figures.
22. In the body copy the figure is written: (figure 1) or (figure 2.)
23. Check there are figure numbers, captions with source credits like this:

Figure 1. Horizontal bar graph titled “Comparing the Whole Populations with the Negroes of the
7thWard” (Source Du Bois ibid.).

Or,

Figure 1. Map of S. molesta infestation, 1978. (Source National Archives of Namibia, CAF 2016).

24. Check tables for alignment and content
25. Quickly estimate any extra time for coding html for zebra tables, etc.

26. Check paragraph breaks for hard-returns (flush and justified).
For Reference: 13.25 CMofS.
Tip: All pars begin flush left after a blockquote.

27. Deletemultiple spaces and tabs using the find and replace function.
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28. Check indents and other defined styles converting underline to either bold or italics.
Change emphasis of underlining to italics, and use headings in the styling.

For Reference: Only use of underline is transcribed handwritten letters, which should be

kept as writ. See 6.2 on CMofS.

29. Fix quotationmarks single and double.
Check all possessive cases singular or plural (CM0fS 6.116, p.408)

- Tip: Make sure they are 6 and 9 in shape. Distinguish between single and double

quotations dependent on English chosen.

- Sometimes a digital quotation marks (single or double) in unquoted text can be

something that still needs a citation. So do query it with the authors so the citation

and referenced is added. Also, make sure by cutting and pasting the text if there is a

string of them in a row.

- Change directional quotations to curly quotes.

- Check length of quotations and indent if need be.

- Put punctuation inside the brackets.

- Check punctuation ahead of quotations.

- Check single versus double quotes.

For British English see CMofS 13.30 and:

American:

“Economic systems,” according to Professor White, “are an inevitable byproduct of civilization,
and are, as John Doe said, ‘with us whether we want them or not.’”

British”

‘Economic systems’, according to Professor White, ‘are an inevitable byproduct of civilization,
and are, as John Doe said, “with us whether we want them or not”’.
(https://www.thepunctuationguide.com/british-versus-american-style.html)

30. Fix apostrophes and smart apostrophes: check all possessive cases singular or plural

(CM0fS 6.116, p.408)

Tip: Fix smart apostrophes like this:

We spent the ’90s in thrall to our gadgets.

Where’d you get (‘em)?

I love rock ’n’ roll (not rock ‘n’ roll).

When it should not have the punctuation between the letter and the apostrophe like

this: It was Smith’s.

Code: Another easy method to produce an apostrophe pointing in the proper

direction is to hold down the Ctrl key as you type the apostrophe twice, or type the

apostrophe twice and delete the one you don’t want. Only one apostrophe will show

on the screen, and it will be pointing in the proper direction (WordTips).

Regularise em dashes.

For Reference: CM0fS for em dashes 6.85–92.
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Tip: Replace all numerical instances with en dashes,Hyphens can be used in words

to break them up l-i-k-e t-h-i-s. Or, 978-0-226-159, check numbers that should

be dashes.

Tip: En Dash is usually to connect numbers and sometimes words: 2023–2040, 11:30

a.m.–4:00 p.m., December 2016–March 2055, or 4 November 2025–15 November

2025. OR, They were in the meeting from 2012 to 2016 (not from 2012–16). Or,

London–Paris, or (1950–). Or Berry–style, or post–World War II years. Or

quasi-public–quasi-judicial.

For universities like Madison–Wisconsin, check their pages for details.

For British-English see CM0fS 6.83, p.338.

EmDashes are used instead of commas, paratheses, or colons and are used to

amplify. For British-English see CM0fS 6.83, p.338. Amplification examples

are—great, fab, and wonderful! In a sentence whereby—they’d been sleepy—but

could still work. They outlined a strategy—a copyediting strategy that would, she

hoped, secure more fun copyediting. They can also be used as a way to signify

speech.

—The Editorial Collective met with Editorial Board, said the author.

—Of course they did!

A 2 em-dash is for missing words like this “The region⸺to the post.” [This needs

to be converted to source sans like this “The region⸺to the post.”

A 3 em-dash is for the same author in a bibliography:

Use this:

⸻

Formultiple do this:

The 3 em dash for 2 or more authors (or editors or translators) as the

previous entry can be replaced with thois character. But not if there

are one more or less authors, and also if the authors are editors or

translators too. See 14.69.

Povinelli, Elizabeth. 2001. “Radical Worlds: The Anthropology of Incommensurability and

Inconceivability.” Annual Review of Anthropology 30: 319–34.

⸻. 2011. “The Governance of the Prior.” Interventions 13 (1): 13–30.

Tip: There is only a comma when there are multiple authors on the same line.

31. Regularise ellipses.

For Reference: CM0fS for ellipses, 13.50–58.

And https://www.writing-skills.com/five-annoying-ways-use-ellipsis

Tip: For an ellipsis . . . leave spaces either side like this, unless it is a punctuation like a colon. . . .

like this.

Code: Like this . . . and make sure they don’t have a breaking space.
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Code: Delete automated hyphenation dashes at the end of a line break. Switch o� hyphenation.

Also for replacing ellipsis so that they don’t go over a line see this:

https://wordribbon.tips.net/T005995_Getting_the_Proper_Type_of_Ellipses.ht

ml

Or do this>>

Code: Type ctrl, shift (arrow), and space bar then . and repeat until you make the ellipsis. Then

find “Word options dialogue box” or search for autocorrect it in the list and change using find

and replace. Paste the one you just made into the autocorrect and save.

32. Check periods in references. Like this:

Povinelli, Elizabeth. 2001. “Radical Worlds: The Anthropology of Incommensurability and

Inconceivability.” Annual Review of Anthropology 30: 319–34.

⸻. 2011. “The Governance of the Prior.” Interventions 13 (1): 13–30.

33. Check punctuation in quotes:

Tip: “Technology is politically significant in its own right", Langdon explains (2020a, 21), “the
machines, structures, and systems of modern material culture . . . embody specific forms of
power and authority” (ibid., 19).I think it should be:
Tip: “Technology is politically significant in its own right,” Langdon explains (2020a, 21), “the
machines, structures, and systems of modern material culture . . . embody specific forms of
power and authority" (ibid., 19)."right"

Tip: CM of S: 6.9: Period is inside a double quotation mark, it is only semicolons and colons that
go outside. It says, "Periods and commas precede closing quotation marks, whether double or
single.

Tip: CM of S: 6.9:When an expression that ends in a period (e.g., and abbreviation) falls at the
end of a sentence, no additional period follows.

34. Check line spacing, font, margins.

Tip: It will either be 1.2 small leading or 1.4 for big leading. The font will be either 12pt
(1.4Leading), 10pt (1.4), 8.5pt (1.2), 8pt (1.2). All margins for every page are set as follows: Top
4cm, Bottom 4cm, Left 2.67cm, Right 2.67cm, and Gutter 0.

35. Review obvious errors with special characters.Note that the following special
characters: em-dashes in Merriweather will convert to another typeface Sans Source
when converting to html.

Tip: What about minus character look-up UNICODE [UNI code=U+2212].

36. Check numbers less than ten are written out except for when chunks of numerical
data are being made.

Tip: Centuries are written out in full like this twenty-first century.

The twenty-first century

Fourteenth-century carrying bag

Twenty-first-century science

A late eighteenth-century dogs

Their home was twentieth century

Noun forms always open; adjectival compounds hyphenate before not after a noun.

37. Run a spell check. Check for obvious spelling errors: it’s its, lead led, breath breathe.

38. Go to protect document and anonymise comments.
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39. Save as: AuthordateReFyearV02.docx

Next Step 1: Either send back to the authors to check referencing.
Next Step 2: or go straight to inline linking and reference checking.

Dear [author],

Please find the following copyedits for your consideration. Please review and send back to me as soon as you can.

Please review (using page 3 of the Final Submission Form for guidance) and send back to me as soon as you can.

 

Usually, we aim for authors to send back to us within two weeks. Do let me know if you needmore time?

 

Best,

 

Amanda

 Dr Amanda Windle, Managing Editor
Editorial Collective at ESTS | 4S

40. Check all hyperlinks and their styling in the main body copy. Make sure you use the
sidebar style pane like this for hyperlinks:

41. Right click on the hyperlinks to check they all work and go through to the various
web pages when they link out and away from the document.

42. Check all references in the body copy use the Chicago Manual of Style and appear in
brackets and look like this:
(Russell et al. 2004, 6)
(Latour 1994; 1999)
(Ally, S., and A. Lissoni, eds., 2018.)
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If you are unsure you can check the submissions checklist on the website, use the
Chicago Manual of Style 17th edition, or look back to past issues, from ONLY issue 7.1
onwards for examples.

43. Go to the reference list at the bottom of the document and check all references
online for accuracy.

44. Make sure all DOIs have been added to all entries that have them. If all DOIs are
missing, make this a job for the author to do. Replace URLs with DOIs wherever
possible. Make sure these are listed in the references. They must be written like this:

Brown, Phil. 1992. “Popular Epidemiology and Toxic-waste
Contamination: Lay and Professional Way of Knowing.”
Journal of Health and Social Behaviour 33(5): 267–281.
https://doi.org/10.2307/2137356.

45. Check that all DOIs are correct, this is often incorrect, and may lead to a di�erent
piece so really needs checking each time.

46. Check punctuation, periods and commas particularly note that there is no comma
after a journal title and that punctuation is within the double quotation marks.

47. Check that all Titles have the standard Upper case for first letters but words like
“and” or “a” are lower case unless they start the sentence or after a colon or
semicolon too. Do not follow the original journal’s style because this will be di�erent
each time particularly for upper case/lowercase use. A quick way to do this and then
manually change the “and” or “a” is to use the: “Capitalise EachWord” feature in
the ribbon:

48. The following checks can be done as you search for each entry of the paper online
hopefully using the DOI link. You can do this by pasting in the DOI, or the hyperlink,
or searching for the title, and then look out for the journal paper or publisher, it may
not be the top search. Do not use Amazon (goes without saying) try and use the
publisher’s own pages, or if that doesn’t work, you can search using Google Scholar
but bear in mind the listings will vary in style (Harvard/APA etc.). You may want to
align your two applications (Word and Web Browser) like this, to keep your place in
your text.
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49. Check that the author names are in the correct order. The first and lastname
ordering then switches when co-authors are listed. Also the order changes for
“edited by” items like book chapters.

50. Delete any duplication of the same citations for di�erent parts of the same volume
book or edited collection.

51. Add all missing DOIs and if there are only a few, then move the lower case titles to
upper case, but if it is consistently wrong, thenmake a note and ask the author to do
this in the next revisions. Amend the first instance and ask them to replace
throughout the document like this: “Please replace the main title words with
uppercase titling, like this one. Please use track changes and fix throughout the
document.”

52. When you change elements also use track changes, but keep any formatting changes
without the track change comments to a minimum. So for instance, you have deleted
5 spaces and a comma, use simple mark-up so that the changes don’t appear in the
space for other comments and track changes. If you are unsure of anything, or the
page is visually messy, highlight it in yellow and make a note in the track changes.
Aim for no more than 10 track change notes showing per page. Like this:
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53. For long co-authored lists, only cite up to 4 authors (Chicago style) then delete the
rest and add et al.

54. Check the first author order is lastname then firstname. Note that the order appears
“lastname, firstname, then firstname, lastname(2), firstname, lastname (3),
firstname, lastname (4), et al.”

55. Check that there is a period after each middle name. “Khoury, Muin J.” or “Muin J.
Khoury” depending on where the name is placed in the order.

56. Check the use of italics is consistent. Note that this di�ers for journal papers and
books.

57. Check that all DOIs have been added.
58. Do not change any of the dashes. These will have been done already.
59. If the references are too messy, and there are too many errors to start inline linking,

then then send it back to the managing editor to check. If it is the case, then we can
the authors will be asked to make corrections before the inline linking is done.

60. For any other queries, just ask the managing editor, rather than guess.

Here are examples of formatting:

Check: Articles: Phan, Thao. 2019. “Amazon Echo and the Aesthetics of Whiteness.” Catalyst:
Feminism, Theory, Technoscience 5(1): 1–39. https://doi.org/10.28968/cftt.v5i1.29586.

Books: Chen, Kuan-Hsing. 2010. Asia as Method: Toward Deimperialization. Durham & London:
Duke University Press.

Besteman, Catherine, and Hugh Gusterson, eds. 2019. Life By Algorithms: How Roboprocesses Are

Remaking Our World. Chicago: University of Chicago Press.

Chapters in edited collections: Anderson, Warwick, and Vincanne Adams. 2008. “Pramoedya’s
Chickens: Postcolonial Studies of Technoscience.” In The Handbook of Science and Technology
Studies, edited by Edward J. Hackett, Olga Amsterdamska, Michael Lynch, and Judy Wajcman,
Third Edition. Cambridge, Massachusetts and London, England: The MIT Press.

Non-English references: Please provide all references in their native language and provide a
translation of that title in English. Capitalize the first letter and any pronouns, and use
parenthesis (square brackets) for clarity, unless conventions in the native language demand
otherwise (e.g. pronouns would not be capitalized for Danish).
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E.g. Books: Kubo, Akinori. 2018. Kikai Kanibarizumu: Ningen Naki ato
no Jinruigaku機械カニバリズム：人間なきあとの人類学 [Machine
Cannibalism: Anthropology after the End of the Human]. Tokyo:
Kodansha.

Similarly, a French translation [e.g the English is capitalized, while
the French is not]
Gilles Deleuze’s What Is Grounding? [Qu’est-ce que fonder?], trans. Arjen
Kleinherenbrink (Grand Rapids, Mich.: New Centre for Research and
Practice, 2015). —TN] 

Same Author and Year: Stengers, Isabelle. (2005a). “Introductory Notes on an Ecology of
Practices.” Cultural Studies Review 11, no.1: 183–96. http://dx.doi.org/10.5130/csr.v11i1.3459.

⸻. (2005b). “The Cosmopolitical Proposal. InMaking Things Public, edited by Bruno Latour
and Peter Weibel: 994–1004. Cambridge: MIT Press.

Online-only Sources: da Costa Marques, Ivan. 2021. “The Authority of Scientific Knowledge,
COVID-19, and Other Challenges.” Backchannels: 4S Blog. Accessed April 1, 2021.
https://www.4sonline.org/the-authority-of-scientific-knowledge-covid-19-and-other-challe
nges/
FloHealth https://flo.health/. App, August 3, 2021.

Deutsche Forschungsgemeinschaft. 2013. Proposals for safeguarding good scientific practice:

Memorandum.Weinheim: Wiley-VCH Verlag GmbH & Co.

⸻. 2015. “DFG Guidelines on the handling of research data.” Accessed October 27, 2020.

https://www.dfg.de/download/pdf/foerderung/antragstellung/forschungsdaten/gui

delines_research_data.pdf.

⸻. 2019. “Guidelines for safeguarding good research practice.” Accessed July 5, 2021.
https://www.dfg.de/download/pdf/foerderung/rechtliche_rahmenbedingungen/gute_wissens
chaftliche_praxis/kodex_gwp_en.pdf.

61. Create bookmarked in-document links. [I haven’t finished this section because of
the Bug in Word. Hope to finish this in December when the bug us fixed].

62. Pattern: WORK BACKWARDS FROM BOTTOM OF PAPER TO TOP adding
BOOKMARKS! THEN DO REFERENCE LIST BOOKMARKS NEXT (top to bottom).
Then add inline links to the reference list (top to bottom). Then add ref links to the
main copy but MOST IMPORTANTLY add them bottom to top.

There are two parts to making links. The Reference list at the bottom, and the

citations in the text. You want to create links between the two.

Before you start, if either the citations or the references show up grey when you copy

them, then you will need to take the references out of Word and use Text Edit to

clear any untoward coding (“make plain text”) that may follow through when the

HTML is created.

Turn o� track changes unless you are changing a reference that is incorrect.

and select bookmark on the ribbon.
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63. Highlight the citation but not the brackets around it in the main copy. Use the insert menu

in the ribbon. Click on Bookmark (might be nested in Link) on the ribbon. Type in name:

AuthornamedateInline. Do not add any spaces or anything else to this. Now, find the same

author link in the Reference list and highlight authorname and create a new bookmark.

Type in name: AuthornameRef. Now highlight the link and create a styling using Smartlink

from the styles pane. Then highlight the same text and click on link and select bookmarks,

then click on the triangle to see the drop-downmenu of the bookmarks and select

AuthornamedateInline. Then, go back to the inline instances of that same authorname and

for each instance, repeat the same process but this time select AuthornamedateRef.

If a reference isn’t added to the main text then highlight the date in yellow and add a

comment: “please add citation to the main text or delete.”

Once all links have beenmade, save as pdf and test the links working as if you were

reading the text.

64. From the Format menu, select Style....

Next to "List:", make sure All styles is selected. In the "Styles:" section, select
Followed Hyperlink, and then click Modify....

Click Format, and then select Font....

From the list under "Font Color:", choose the color you want. To save your changes,
click OK, and then OK again.

Checking Inline Links
Save the word document as a pdf (for web). Open up the pdf in acrobat and click on
the links back and forth between the inline links and the pdf. Note any that are
incorrect. The alternative way to check inline links is to work only in MSWord. This is
needed when there are bugs in the functionality of latest software (which happened in
October 2021). It means when you click on the links in Word the links will change colour.
This won’t a�ect the pdf output but it will look di�erent when testing.
You may find it useful to open up the pages for going back and forth, but also use the
search so you don’t overdo the scrolling!
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You may want to keep a note of any errors you find so you can tick them o�when
you check your amends. All this happens before you send to the editor/author.

Common Errors:
Before correcting an error try not to change the bookmark, it’s often the link that’s
incorrect, and once you click and change a bookmark you are interrupting the order
of which that reference is to be found in the text, and once you change that order,
you will have to find the first link and then correct it again.
An inline link that doesn’t goes to the reference, but the reference doesn’t take it
anywhere needs a link adding.

15
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An inline link that goes to the reference but instead of going back to the first
instance of the reference earlier in the document, jumps to a later page say page 15,
will mean that a link is wrong somewhere. Start by remaking the first link to say
page 2 but going through the process of bookmarking and inline linking again. If
that doesn’t solve it, then look carefully at the code, have you linked to 2002b rather
than 2020a or to a di�erent reference entirely. Double check everything then test
again until it is fixed.
When you correct an inline link say on page 7, it may then become the dominant
inline link, so do a search for the author’s last name and see if there is an inline link
earlier in the document, that way you know if you then need to go an inline link back
to that first inline link.
If you’ve tried everything and it seems like Word is just not linking, delete the copy
in the text and write it out again and add all inline links on the fresh word.

If the date in the main body copy isn’t correct, and doesn’t match the reference in
the reference list you need to make notes in each place this is repeated. The same
applies if you change the reference date. Do this by writing “2016?” in the comments
say if the date says 2017 but you think this is incorrect, and again in all instances in
the body copy. Bear in mind that date changes by a few years can be the di�erence
between reading something online, in paperback or hardback, and sometimes longer
times can be a change in edition, so don’t assume the date is incorrect, check
editions and various publication instances.

If you are really stuck on why something isn’t working, write the problem out
long-hand and read it back to you.

65. Save as: AuthorlastnameInLReVyear.docx.

66. Go to protect document and anonymise comments.

Stage 3 MARK-UP
MuP
67. Save as AuthordateMUpYEARV01.docx

68. Proof for sense
Tip: Query or correct, if possible—illogical, garbled, repeated, or missing text.

69. Proof for fact
Tip: Source check main copy and captions.
Check for commas after the read-through.

70. Send to author as: AuthordateMUpYEARV02.docx and AuthorlastnameYEAR.pdf..

TEMPLATE
Title: “Mark-Up and Copyediting”

Dear [author],

Please find the following copyedits for your consideration in two documents. You can use the pdf format for checking

in-line links and hyperlinks. Please review and send back to me as soon as you can. Please review (using the Final

Submission Form for mark-up) and send back to me as soon as you can.

Usually, we aim for authors to send back to us within two weeks. Do let me know if you needmore time?

Best,

Amanda

Dr Amanda Windle, Managing Editor
Editorial Collective at ESTS | 4S

Stage 4 AFTER AUTHOR’S PROOF
MARKING ITEMS (1st Amends)

MiM
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71. Save version as: AuthorlastnameMiMYEARV01.docx
72. Compare using Di�erenceChecker online to track changes or another free program.

Do not work on the version given by the authors.
73. Run a spell check.

74. Check bibliography.

75. Check double spacing and par breaks.

76. Identify all graphic elements like tables and images.

Tip: When handling these appropriately note that this may di�er when converting the word

document to an html file. All images should be changed in Photoshop to: png. 300DPI, RGB,

Width, and Height.

77. Check inline links in pdf format.

Tip: From the Format menu, select Style....

Next to "List:", make sure All styles is selected. In the "Styles:" section, select Followed
Hyperlink, and then click Modify....

Click Format, and then select Font....

From the list under "Font Color:", choose the color you want. To save your changes, click OK,
and then OK again.

78. Check for obvious spelling errors: it’s its
79. Edit and delete author/editor comments.

80. Send to author: Set a deadline 1 week. The file will come back to you as:

Authorlastname_MiM_yearV06.docx

“Mark-Up for Production”

Dear [author],

Please find the final mark-up for your consideration in two documents. You can use the pdf format for checking

in-line links and hyperlinks. Please review and send back to me as soon as you can.

Usually, we aim for authors to send back to us within one week. Do let me know if you needmore time?

Best,

Amanda

Dr Amanda Windle, Managing Editor
Editorial Collective at ESTS | 4S

Stage 5 AFTER AUTHOR’S PROOF

ANNOTATIONS (2nd Amends)

AnN
81. Save version as: AuthorlastnameAnNYEARV01.docx

82. Quick Steps

a. Save version as: AuthorlastnameAnNYEARV01.docx

b. Compare using Di�erenceChecker online to assess howmany track changes have been

made.

c. Do not work on the version given by the authors.

d. Run a spell check.

e. Check bibliography.
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f. Check double spacing and par breaks.

g. Check again using Di�erenceChecker online to track changes or another free program.

83. Send to author. Set a deadline of 3 days. The file will come back to you as:

AuthorlastnameAnNYEARV01.docx

Stage 6 CORRECTIONS

(3rd Amends)

CoR
84. Save version as: AuthorlastnameCoRYEARV01.docx

a. Save version as: AuthorlastnameAnNYEARV01.docx

b. Compare using Di�erenceChecker online to assess howmany track changes have been

made.

c. Do not work on the version given by the authors.

d. Run a spell check.

e. Check bibliography.

f. Check double spacing and par breaks.

g. Check again using Di�erenceChecker online to track changes or another free program.

85. Send to author. Set a deadline 48hours. The file will come back to you as:

AuthorlastnameCoR5YEARV01.docx

Stage 7 REVISIONS

(4th Amends)

ReV
86. Save version as: AuthorlastnameReVYEARV01.docx

87. Pay careful attention to the design graphics in header and footer.

88. Check there is no keyword capitalization. They do not need to be in alphabetical order.

89. Make sure all blockquotes have linked page numbers.

90. Check author a�liations are up to date.

91. Make sure the author order us correct betweenmetadata and header.

92. Check all bookmarked in-document links and hyperlinks. And page breaks.

93. Send to author andmake sure there you get sign-o� on last version, and all permissions

are in place. Make sure the DOI is added once you approve the file for production and

assign is an issue number on OJS.

Stage 8 CREATE PDF CODE HTML
CrE
94. Save version as: AuthorlastnameCrEYEARV01.docx if needed. If not, go straight to the next

step.

95. Check gap above Abstract should be 2 par breaks styled in Heading 2.

96. Check title break in main heading.

97. Check indented pagination is the same, or di�erent for 3k length writing.

98. Check lowercase on keywords.

18



LASTNAME et al. CHECKLIST

99. Check page number (style pane) and right side placement.
100. Check last page does not havemetadata at the bottom.

101. Check spacing on references lists.

102. Commas in last accessed dates.

103. Check header graphic is flush right.

104. Add notes to the bottom

105. Check ellipses . . . . if they go over a page.

106. Hand code: Copyright Meta—add par breaks to separate the three sentences.

107. ADD page numbers and running heads short title fits.

For Reference: All pars begin flush left after a blockquote. 13.25 CM of S.

Code: Sometimes there is alt text in the jpgs which picks up in the HTML. This can be

checked in the code using Visual Studio Code.

Code Fix: Problems with the last page showing up? Then click on shift(apple key)

and backspace (delete) at the top of the page and delete.

Code Fix: Problems with the header and footer appearing on the last page?

Double-click the footer to select the footer ribbon. Unclick “link to previous.”

Code Fix: Problems with the columns adding a section break to next page? Then do

this:

In Word, choose Word>Preferences, then select View.

In the Show Non-Printing Characters section, check All. OK out.

Now you can see the section break as a pair of light blue lines with the

section break type in text. Does it say Section Break (Continuous)? If it doesn't,

follow these steps:

Click just below the section break, so your cursor is flashing in the

section created by it.

Click on Layout>Margins>CustomMargins.

Select the Layout tab.

Change the Section start: dropdown to Continuous. OK out. The section break is

reset to the right type

108. Insert soft returns when checking placement of DOIs on a new line.

109. Check material in italics, bold, small capitals, size, font, indentation.

110. Check placement of images and tables in Word format and create a new folders PDF
and HTML. Use page 137 of CM of Style.

111. Within these folders save the current Word document author.lastnameHTML.docx.
Make sure the document has no page breaks and runs constant in all its elements.

112. Now save the same file as authorlastnamePDF.docx.Now add any page breaks and changes

to the tables and images so that no headers or end of paragraphs are left on their own. The

content should flow next to the headings and same for images and their captions. Read

tables for alignment and content. Then save this as a pdf (web).

113. Save version as: AuthorlastnamePDF.docx.

114. Save PDF (for web) version as: Authorlastname.pdf.
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Stage 8a CREATE HTML

CdE
115. Open AuthorlastnameCrEYEARV01.docx
116. Save as AuthorlastnameHTML.docx

Stage 8b CREATE HTML
117. Make sure only core styles and custom styles have been used in the Word document.

118. Manually add the author names:

Hand code. Format document in Visual Studio Code (VSC).Make sure you use Prettier

plug-in fortifying up the coding and for applying colour mark-up. To do so, open Folder

“7.2” and trust this folder.

(a) Author headers

- Start by adding <p> </p> breaks around the n. of columns needed per paper.

For speed cut and paste below.

<p>FIRSTNAME LASTNAME<br />AFFILIATION<br />REGION, REGION,<br

/>COUNTRY</p>

<p>FIRSTNAME LASTNAME<br />AFFILIATION<br />REGION, REGION, <br

/>COUNTRY</p>

<p>FIRSTNAME LASTNAME<br />AFFILIATION<br />REGION, REGION, <br

/>COUNTRY</p>

119. Add the header and footer styling in Visual Studio (now done in Mammoth).
120. Fix columns on title.
121. Ordered and Unordered Lists:

- Ordered, Unordered lists work by default and feature styles to control margin and

spacing.

- Ordered lists that require special numbering formats (Not 1, 2, 3) require the additional

paragraph CSS styles applied manually to the <ol> tag:

1. 2. 3. 4. etc is the default behavior of <ol>

i. ii. iii. etc = <ol class="listLowerRoman><li>etc</li></ul>

I. II. III. etc = <ol class="listUpperRoman><li>etc</li></ul>

a. b. c. etc = <ol class="listLowerLatin><li>etc</li></ul>

A. B. C. etc = <ol class="listUpperLatin><li>etc</li></ul>

No bullets = <ol class="listNone><li>etc</li></ul>

122. Tailor Zebra tables, check tables, and figures against pdf.
123. Hand code: par breaks.
124. Hand code:Hyperlinks and in-line links.

125. Check all bookmarked in-document links and hyperlinks. Check for bugs, sometimes the

code is the wrong way around.

126. And page breaks (there should be none!).

127. Hand code: Copyright Meta—add par breaks to separate the three sentences.

- Apply Word style 'copyrightMeta' to the paragraph and this will be mapped in the CSS

andmoved to the base of the document by Javascript.
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- The copyrightMeta paragraph should NOT be added to the Word page footer as it cannot

be removed from the footnotes list. It should be a text box styled to match a footnote at

the base of page 1.

INWORD:

Copyright, Citation, Contact

Copyright © 2021 (Estrid Sørensen and Laura Kocksch). Licensed under the Creative Commons
Attribution-NonCommercial-NoDerivatives 4.0 International (CC BY-NC-ND 4.0). Available at
estsjournal.org.

To cite this article: Sørensen, Estrid, and Laura Kocksch. 2021. “Data Durability: Towards
Conceptualisations of Scientific Long-term Data Storage.” Engaging Science, Technology, &
Society 7.1: 12–21. https://doi.org/10.17351/ests2021.777.

To email contact Estrid Sørensen: estrid.sorensen@rub.de.

HTML CODE:
/p>

<h2>Copyright, Citation and Contact</h2>
<p>
<p>

<sup> </sup>Copyright © 2021 (Estrid Sørensen and Laura Kocksch).
Licensed under the Creative Commons Attribution-NonCommercial-NoDerivatives 4.0
International (CC BY-NC-ND 4.0). Available at estsjournal.org.

</p>
To cite this article: Sørensen, Estrid, and Laura Kocksch. 2021.
“Data Durability: Towards Conceptualisations of Scientific Long-term Data Storage.”
<em>Engaging Science, Technology, & Society</em> 7.1: 12–21. <a href="https://doi.org/10.17351/ests2021.777."
>https://doi.org/10.17351/ests2021.777</a>.
<p>To email contact Estrid Sørensen: <a href="mailto:estrid.sorensen@rub.de">estrid.sorensen@rub.de</a>.
</p>

128. Check Endnotes and Referencing their styling.

Bibliography

- Apply Word Paragraph style 'bibloReference' to all items in the

References section this will map to a css style bibloReference to them

and create the indent style and links. The links themselves will need to

be addedmanually.

- The in-document links to and from the reference list are converted to id

tags, but the hrefs will need to be addedmanually.

Hyperlinks and in-line links. For hyperlinks within the text, divide the VSC page into two

screens, (left screen: for inline links and Right for reference links, basically the top and bottom

of the document). It should look something like this:
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- Hrefs from id tags require handcoding. Search for “id= in” VSC to find links

like this inline document link.

- Make sure that the id and href are within the paragraph break.

- Compare the Inline code (left: how it will appear initially, right: coding

changes to make)

- Compare the Reference code (left: how it will appear initially, right: coding

changes to make)

From:

<p class="bibloReference">

Nisbet, E., M., Manning, E. Dlugokencky, et al. 2019. “Very Strong Atmospheric Methane Growth

in the 4 Years 2014–2017: Implications for the Paris Agreement.” <em>Global Biogeochemical

Cycles</em> 33: 318–42. 

<a href="https://doi.org/10.1029/%202018GB006009"

>https://doi.org/10.1029/ 2018GB006009</a>.</p>

Add, reorganize and then check that the id has an href and # anchor within the closed par break.

Below shows an end of document reference linking back to the main text. The opposite would be

added to the inline reference to match. The naming convention is by author and year, but if

there are more than one instance of an author then add the date too, Povinelli, 2001, and
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Povinelli, 2011 and so on. Make sure that the entire link is highlighted so that the year is

highlighted if there is more than one instance of the same author. Link to the year if the author

cited has more than one text.

To:

<p class="bibloReference">

<a href="#NisbetInline" id="NisbetRef">Nisbet, E., M., Manning, E. Dlugokencky, et al.

2019.</a>

“Very Strong Atmospheric Methane Growth in the 4 Years 2014–2017: Implications for the Paris

Agreement.” <em>Global Biogeochemical Cycles</em> 33: 318–42. 

<a href="https://doi.org/10.1029/%202018GB006009"

>https://doi.org/10.1029/ 2018GB006009</a>.

</p>

129. Save as: Authorlastnameyear.htm

Stage 8c CREATE PDF

130. Go back to Authorlastnamepdf.docx document.

131. Make sure the header is nicely placed across two lines.

132. Check page pagination breaks, and images placement between pages and adjust page

pagination for PDF.

133. Add page numbers to the footer and to page 2 onwards.

Stage 9 EiC / EC EDITS FINAL PROOF

PrF
134. Proofing checklist.

135. Check for bugs between HTML and PDFs. Bugs include: inline links, special characters.

136. Go into the metadata for each item and update the abstract, title, author order in the
first metadata tab.

Go to the third metadata tab and update the reference list. For more, look at:

https://www.crossref.org/services/reference-linking/
https://www.crossref.org/documentation/content-registration/descriptive-metadata/references/
Including references (or adding them to an existing deposit) can be done by:
Crossref XML plugin for OJS: using the OJS reference linking plugin, you can include references in your
initial deposit, or add them later.
Web deposit form: the web deposit form can’t currently be used to add references when you first
register your content, but you can use Simple Text Query to match references and add them to an
existing record.
Metadata Manager: If you’re still using the deprecated Metadata Manager, there’s a field where you
can add references and Metadata Manager will even match your references to their DOIs. If you want
to add references to an existing deposit, simply find the existing journal record, add your references,
and resubmit. Learn more about updating article metadata using Metadata Manager.
Direct deposit of XML: you can include references in your original deposit, or add them later. Learn
more at how to deposit references for users of direct deposit of XML.

Stage 10 CREATE ISSUE

IsS

137. Look across all the issue writing and compare for line spacing, font, margins. And
against issue 7.1.

Create a new issue form “Issues tab in OJS.” Select each of the items for Issue and Number, but
deselect the tick box for title and leave it blank when prompted:
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138. Test HTML using a WC3 tool.
139. Test on mobile and tablet format for responsive design by decreasing and increasing

the file size.
Stage 11 PROMOTE ISSUE

PrT

140. For the promotion on Twitter:

Promoting on Twitter

(b) Add tweet content by quoting the title, or using the paramedic method (by

Richard Lanham, 2007) to create a headline.

(c) Follow it with “by [author’s Twitter handle]. To add Twitter handles for each

author, or the author name if they don’t use Twitter. Check order of

co-authorship. Requote tweet if the list is too long. You can find this detail in the

final submission form.

(d) Create a short doi (https://shortdoi.org/) for the article and paste it after Read

more here:

(e) Add image and alt-text description. Create a short URL link using Bit.ly for where

the image is sourced. Usually look in Flickr for open licensed material or

Unsplash.

(f) Add hashtags. Try and incorporate them into the main sentence to highlight the

keywords. Omit generic words like #STS where you can.

Example tweets and alt-text:

TEMPLATE: Roll-out of the UK's #GPDPR in 2021 has animated fierce debates around the
aspirations to use sensitive health information. Read more on #Trust + #HealthData by Nishtha
Bharti @cian@melaniesmallman@jamesgswilson Read here: https://doi.org/g27x #STS #NHS
#PublicEngagement
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While tracking #periods can be a form of self-surveillance in 6 interviews @alillyf
@biomedselfsoc & @giulia_de_togni elaborate further on the #queering of #menstruation
#technologies for sidestepping fertility.

Here: https://doi.org/g246

#menstrualhealth #hormones #periods

Alt text: Image shows a gra�ti wall in Montreal and reads "vagina bleeding is human" available
here: https://bit.ly/3vrPfemwith a CC0 1.0 Universal (CC0 1.0) Public Domain Dedication.

TEMPLATE:
Estrid Sørensen & Laura Kocksch "initiate discussions on the making of long-term #data
storage" in relation to "data #durability."

Read more here by@estridsorensen +@datalora: https://doi.org/g24z

#Infrastructure #Materiality #Temporality #DataPractices

ALT TEXT: Image shows data logging, a series of plastic containers with data boards and
connecting screens. This image is sourced via Flickr under the CC0 1.0 Universal (CC0 1.0) Public
Domain Dedication here: https://bit.ly/3C8kTjD

Twitter table.
141. Create a table tweeting to the timezones of the authors using TweetDeck. The

timezones can be scheduled to their a�liation on the first page of their published
piece. All tweets are sent about 6.30pm Mon-Fri. You will find this schedule in the
Issue Checklist with all the other Copyediting/Galley file forms. Rather than use
TweetDeck, you can find the saved tweet in Twitter and click on the calendar link
and schedule the tweet from there.

Listserv
142. Promoting on Listservs

Tip: Create a short email and send at the same time as newsletter. Here is an example text. Use

the full signature on this email for the collective. There are 5 listservs in the contacts of Gmail,

so go to contacts and use the Listservs group and BCC the E-i-C.

TEMPLATE:

ESTS: Introducing our latest journal issue 7.1

Engaging Science, Technology, and Society (ESTS), the Open Access (OA) journal of the Society for
Social Studies of Science (4S), was launched in 2015. We have recently published our newest
Issue, 7.1 on our newly redesigned website: you can download our content as a PDF or read
online via a laptop, tablet or smartphone with the HTML format. All citations and references are
inline linked and have a new look and feel to match our new design.

Mailchimp
143. Promoting via our the ESTS newsletter via Mailchimp

Tip: Create a campaign in Mailchimp using the credentials document for the logins. See an issue

campaign posted below.
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Technoscience
144. Promoting on Technoscience newsletter.

145. Check with webmaster to add issue

146. Check indexes. Check DOAJ has listed the issue on their website.

Twitter Promotion Checklist
Author Timezone Scheduled Day Scheduled Time for 6.30pm in

the timezone of the author
Firstname Lastname London, UK 4th Jan 11.30pm BST
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Stage 12 ERRATA

1. How to make a correction in OJS 3.1.

Search online for OJS’s Journal Policy andWorkflows guide for “Retractions
and Corrections.”
Correction - https://www.cjhp-online.ca/index.php/cjhp/article/view/3285
Original Publication -
https://www.cjhp-online.ca/index.php/cjhp/article/view/3252

OJS 3.1 does not o�er the versioning feature that this journal (CJHP) has, but if you
are planning on updating the original PDF well then this can be uploaded as a new
galley. 

I hope that this information is helpful, but please let me know if you have any
additional questions.
2.

ERR
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